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Lesson Objectives 
In this class, we will be discussing basic procedures to obtain a representative surface model (TIN) of a 
project site from a point cloud resulting from LiDAR or areal photogrammetry, including common 
feature extraction steps and virtual surveying tools. It is important to understand that the lessons 
through this class are not intended to be fully comprehensive as all point cloud projects pose their own 
unique set of challenges.  

For this lesson, we are going to use a data set collected using an Autel EVO II drone in Southern 
California. The drone images were processed in Carlson PhotoCapture from which we will utilize the 
orthoimage as a CAD underlay and then the dense point cloud for feature extraction to create a surface 
in CAD. See image below.  

 

 

 

The objectives for this class are: 

• Starting a Point Cloud project 
• Import/Export point clouds 
• Defining a work zone 
• Decimating the point cloud by applying filters (if necessary) 
• Automated feature extraction (buildings, parking lines, curbs, sidewaks, edges) 
• Drawing polylines to CAD 
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• Extracting points by grid 
• Virtual surveying (field-to-finish) 
• Drawing points to CAD 
• Creating a surface in CAD 

 
Carlson Point Cloud Advanced Overview 
Carlson’s Point Cloud Advanced module provides the ability to go from field scan (aerial/terrestrial) to 
finish plat from large data sets by allowing users to process millions of data points. Filter or decimate 
points, extract features such as walls, roofs, parking lines, road markings, sidewalks, edges, curbs, field-
to-finish, and extract points by grid. With Point Cloud Advanced you can also triangulate from the dense 
point cloud, calculate volumes, extract profiles, extract trees/poles, cut sections and export solids.  

 
Carlson Project Setup 
Begin by creating a new Carlson project. 

• Open Carlson by double-clicking the icon on your desktop. 
• In the Start Page, click New Drawing.  

 
 

• In the New Drawing Wizard dialog, keep Drawing Type set to DWG and Use a template drawing 
toggled on. 
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• In the Template Drawings dialog, select carlson.dwt and click Finish. 

 
 

• In the Starting Drawing Wizard dialog, click Set.  

 
 

• You will now create a new directory for the project. In the Drawing to Create dialog, click 
Browse and then create a new folder under the Carlson Projects directory named Point Cloud 
Advanced Lesson (if you haven’t done so already).  

 
 

• In the File Name field, type Point Cloud Advanced Lesson and then click Save to return to the 
Drawing to Create dialog and Save again to return to the Wizard. It is not necessary to type the 
file extension. 

• Notice the Scale Settings, the project scale is used to control the symbol height and the plotted 
height/printed height of the text. This will set the project default and can be changed later if 
necessary. We will keep the default value of 20. 

o As a reminder, if the desired plotted text height is 0.08 inches, at a 1:20 scale this text 
will need to be 1.6 drawing units.  

• The project site is in Southern California therefore you need to set the projection accordingly to 
place the orthoimage and additional data on the right spot in the drawing. Set the Projection to 
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State Plane 83, Zone to CA 6, and Lat/Lon Datum to NAD83. If you select None, you can change 
the projection settings later if necessary. 

• The Startup Wizard Data Files dialog will open. 

 
 

• The Data Path allows you to set the location of the different project files if you want to 
distinguish them.  

• The CRD File or Carlson coordinate file is the external file that Carlson uses to store the point 
data, i.e., point numbers, northings, eastings, elevations and descriptions. Keep the default path 
and choose New to start a new file. CRD files can be used to import the survey data from the 
field crew using SurvCE/PC.  

• Keep Import Point From set to None. 
• Click Next to complete the Wizard. 

 

Inserting an Orthoimage 
We’ll start the CAD drawing by inserting the orthomosaic to give us a reference for the site. The image 
can be inserted using either the tool found in the Survey or GIS modules. For this lesson, we’ll use the 
Survey menu. 

• From the Settings menu, select Carlson Menus  Survey Menu. Note that you can use the 
toolbar too. 

• In the Survey module find the GIS menu  select Place Image by World File. 
• Browse to the folder where you copied the “Point Cloud Advanced Lesson” data set for this 

lesson and select Orthoimage.jgw. PhotoCapture will generate both a JGW and a TFW files, I 
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provided you with the smaller jpeg format for simplicity. 

 
• Check the Layer box and verify the layer that the image will be inserted in. 
• Make sure Place in background is toggled.  
• Click OK. 
• You’ll want to Zoom to Extents to view the results. 

 

Creating a Point Cloud Project 
To provide the ability to work with the large amount of data associated with a point cloud, Carlson’s 
Point Cloud will manage the point cloud data through the Point Cloud Manager. Inside of the Point 
Cloud Manager you will find all the edit, creation, and extraction tools to work on your projects.   

• From Settings menu, select Carlson Menus  then Point Clouds Menu. The Point Cloud 
Manager window will open. If you already had the Point Cloud Menu active, you may need to 
expand the Point Cloud menu and select Project Manager to open this window.  

 
 

• Click the New button. 

 
 



 
 

Carlson Software | 33 East Second Street | Maysville, Kentucky USA | 606.564.5028 
www.carlsonsw.com 

• Type Point Cloud Advanced Lesson as the file name, then click Save. 
• You will be prompted if you want to create a new project, click OK. 
• A new point cloud project tree will be displayed in the Project tab. 

 
 

The Point Cloud Manager is also made of five tabs. The Project tab displays the project tree and has the 
tools to edit settings besides saving and creating point cloud projects. The Scene tab which holds basic 
display settings including point size and smoothing and, importantly, the tools to control the display of 
regions/categories in the point cloud. The Camera tab which has the basic display controls (view point, 
projection style, clipping planes). The Action tab from where you can access all the Selection, Edit, 
Transform, Create, and Extract tools. The Data tab that displays the coordinate system and object 
references.  

In the Project tab, the project tree displays five main categories: Clouds – this will list the point clouds 
that you import or you create as you work on the project. Instrument Data – allows you to bring data 
from ground scanners such as scanner positions and targets. Processed Data – you will find the 3D 
polylines, coordinate points, and layers. TINs – you will surfaces created directly from the point cloud 
data or imported from your CAD project. Scenes – scenes are used to display the point clouds and are 
associated to specific point clouds. 

Point Cloud Project Settings 
Before we get started, it is good to check the point cloud project settings. 

• Click the Settings button. (gear icon) 
• You can change the Units’ precision. 
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• Naming Conventions, particularly the number of digits and suffixes used as you apply filters and 
add data. You can keep defaults. 

• Viewer settings, from which you can change background and other colors. Importantly though, 
you can choose to allow to “View Multiple Scenes” and whether or not to “Show Warning” 
when opening/closing the scene viewer to prevent duplication of view. Having multiple scenes 
open may be not only confusing but also taxing on your computer’s memory. I recommend 
having both toggled off.  

• You can makes changes to these settings per project type and save them as configuration files in 
the Dialog Settings tab. In the History tab you can toggle on logging the command history, 
timestamping command history and object creation, and change the auto-save options.  

• Lastly, in the CAD Settings tab, you can set auto draw option, which I do not recommend turning 
on as it will slow you down as it will draw the CAD object every time you issue a command.Don’t 
worry, to draw in CAD only takes one click later. 
I recommend turning on Use CAD’s CRD for PointCloud’s Coordinate Points as this will keep your 
Carlson project CRD file synchronized. 

 
 

• Click OK to close and save the changes. 

 

Import the Point Cloud Data 
The point cloud data that you will be processing may come from a terrestrial scan, publicly available 
LiDAR data and aerial photogrammetry data. It is important to know that when working from ground 
scans, Point Cloud can handle different scanner setups which will allow you to get a true 3D 
representation of the site. Once these ground scans are registered, they would have obtained a 
coordinate system and Point Cloud can be used to merge this data.  

For this lesson we will be using a point cloud obtained from an aerial survey using an unmanned aerial 
vehicle (UAV). It is important to note that the flight was done with the objective to optimize feature 
extraction and therefore a low altitude flight was done (130’ AGL) with rendered a low 0.03’ ground 
sampling distance (GSD) horizontally and 0.12’ vertical GSD on average.  

Let’s import the dense point cloud resulting from the photogrammetry process in Carlson PhotoCapture. 
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• In the Project tab, right-click on Clouds. Then select Import, and LiDAR (.las/.laz) 

 
 

• Select the dense_point_cloud file provided in the compressed Point Cloud Advanced Lesson.zip 
file. This will open the Change LAS Projection window in which you can see the number of points 
that will be imported as well as confirm the projection. For this lesson, the point cloud has 26 
million points and the projection is NAD83 (2011) / California Zone 6 (EPSG: 6426). 

 
 

In this case, the projection and units are correct therefore there is no need to apply any transformation 
during the import process. In addition, because this data is coming from a photogrammetry process, 
there isn’t a need to decimate the point cloud either. Keep in mind that for data coming from other 
sources, it may be recommendable to apply some filters during import. For example, data collected with 
a ground scanner may have a high density of points in and around 20’ from the scanner that can be 
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decimated reducing the number of points that you will need to deal with later. Also good to know, if 
your data was classified during the registration process, an additional window will open prompting to if 
you want to keep the classifications – if you accept Carlson Point Cloud will convert into Regions which 
can be used to turn on/off their visibility and for selection sets.  

• Click OK. The import time will vary depending on the size of the cloud data.  
• Once completed, you will be prompted if you want to view a scene with the new cloud data, 

click Yes. The create new scene window will open. I recommend toggling off Perspective Point 
Sizing and Point Smoothing for clear initial display. Also, make the Point Size of 1. For this 
lesson’s data set, Direct Color is recommended but know that there are other options.  

 
• Notice that the point cloud listed in the Project Manager displays the .las file name and will be 

sorted in alphanumeric order. You can rename and simplify. Right-click on the point cloud, then 
select Rename. Name it 01- Original Cloud. 

• At any time, you can check the point cloud properties to get an idea of number of points, 
position ranges and whether it contains classifications. To do this, right-click on the point cloud 
name and select Properties. 
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• Click OK to close. 

 
Navigating the Scene(s) 
As mentioned earlier, as you work with the data, you may develop one or more point clouds which will 
be associated with their individual scenes.  

 

You can navigate the point cloud in the scene window in multiple ways. You can zoom in and out using 
the middle-button wheel in your mouse. Pressing the middle-button will behave as panning. And, left 
clicking will allow you to rotate the view just are when you work with Carlson’s 3D Viewer. In the toolbar 
you will find helpful shortcuts to set the view to top, front, perspective, etc. Take a moment to review 
these tools. 

 

 

Defining the Working Area 
As mentioned at the beginning, the goal for this lesson and for many projects is to obtain a 
representative surface model (TIN) of the project site from the point cloud data. With that in mind, it is a 
good practice to isolate or create a point cloud that is sub-set of the complete project. For this lesson, 
and to illustrate the steps, we will remove the street and shoulder areas on the west side.  

• Start by changing the scene view to Top. 
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• In the Project Manager, open the Action tab. In this tab, we will use the Perimeter tool under 
Selection Set. Using Perimeter Inside, we can draw a boundary to select all the points we are 
interested for our study. 

 
• Select an area similar to the image below that will include only the park and streets we are 

interested in. 

 
 

• To create the isolated, work area, from the Action tab, click the Cloud button in the Create 
section. 

 
 

•  Name the resulting cloud 02- Working Area. And click OK. 
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• You will be prompted “Would you like to view the new cloud?”, click Yes. This will close the 
current scene and create a new scene associated with the newly created point cloud. The 
software will remember the settings you used last when the first scene was created. The 
resulting view will look similar to the image below. 

 

 

Clean the Point Cloud Data 
In this case, the resulting working area cloud is still over 20 million points which isn’t an issue for Carlson 
Point Cloud. In addition, and to reiterate, this data set came from aerial photogrammetry using a UAV, 
therefore the point density is good for our intended feature extraction. Therefore, I wouldn’t necessarily 
recommend decimating or thinning down this cloud. But you may encounter projects with larger data 
sets or clouds from aerial or terrestrial LiDAR sensors in which case it is good to mention some of the 
tools.   

Let’s start with the simplest Clean Cloud filters which can be easily accessed by right-clicking on the 
point cloud that you want to decimate. The Clean Cloud window offers the following: 

Duplicated Points – this method searches por two or more points that are within the Distance 
Threshold and then will remove them. This method is typically fast and helps reduce much of the 
redundancy in the data. For example, data collected with a ground scanner will have more 
points than necessary right next to the scanner. 

Isolated Points – searches for points that have less than Minimum Neighbor Counts within the 
threshold and delete them. 

Redundant Points – this parametric method is more useful when needing to reduce the flat 
areas down to one point. It will create a user-defined box and check how the points inside of it 
fit the plane and/or have a color match.  

If you are looking to decimate a point cloud with these filters, I recommend applying the Duplicated and 
Isolated Points filter first. Then, apply the Redundant Points second. For the redundant point 
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parameters, I recommend small sampling boxes, thus a Box Length and Width of 0.5, a Box Height of 
0.25, and a Residual Tolerance of 0.03 will render good results. Note that after applying the filter(s) the 
result will be viewed as a new point cloud. Following the naming convention proposed earlier, you could 
name this cloud “03- Working Area Cleaned” and so on.  

 

Resampling the Cloud Data 
Resampling provides two additional methods to decimate the point cloud data which can be somewhat 
more aggressive than those found in the Clean window. The two methods: 

Step – this method reduces the cloud to 1/Step it’s current size. It is fast but at the cost of being 
less intelligent. 

OC-Tree – analyzes the data by using user-defined bounding boxes to search for minimum and 
maximum numbers of points within the ranges and deleting points. This method may take a few 
minutes to complete depending on the number of points in your point cloud data. 

Once again, OC-Tree is my recommended filter and it’s application should be in small boxed areas.  

 

Extracting Roofs/Walls 
To reiterate, for this type of photogrammetry data set, there isn’t a need to decimate the cloud to begin 
feature extraction. So, let’s start by finding the buildings before we bare-earth the cloud. 

• Open the Action tab. And click on Building in the Extract frame. 
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• There are three extraction methods, but we will go for the simplest, click on All. This will allow 
the software to scan the complete cloud looking for roofs. 

 
• The Minimum Wall Height will help filter out walls of less than that height. For example, this will 

prevent the software from resolving a small landscaping wall or fence as a building wall. The 
Story Height is used as reference to determine that ‘planes’ found at different elevations may be 
building roofs. Keep the default values and click OK.  
Depending on the point cloud size (and your computer), this process may take a few minutes. 
For this data set, it will be less than a minute to resolve you will see a 3D polyline drawn around 
the building.  

• Click End Action to close the panel once the process is finished.  

 

Editing Layers 
In the previous step a 3D polyline was created and drawn in the default Building_Outline layer. Great 
opportunity to familiarize you with the Layer Manager. 

• Open the Project tab. 
• You will see that now the Processed Data tree has been expanded to show the newly created 

polyline in the Polylines branch and that a new layer was added. 
• Right-click on Layers, then click on Edit. 
• You can import layers from the project’s CAD drawing by clicking the Add button – great if you 

are working from a template. Or import a layer standard file by clicking Import. 
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• For this lesson, we’ll simply change the color for the Building_Outline layer by clicking on the 
Color field on the list.  

 
• Choose red and click OK. 
• Click OK to close the Layer Manager. 

The building outline polyline will be displayed in red.  

 

 

Applying Bare-Earth Filter 
Now that we have the building outline, let’s go ahead and remove the building, vehicle(s), trees and 
other non-ground points from the data set. We can automate the removal of these data by applying one 
of the three bare-earth filters. 

By Expansion (recommended) – the program will determine ground the ground plane in an area 
and then expand the solved ground plan by proximity until it has resolved the complete site. 
There are no parameters to worry about and you can select to also create a TIN from the 
resulting data.  
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By Profile – this method works by drawing a 3D line away from the selected position and seeing 
if it slopes too sharply, removing any vertical segments and keeping any flat segments. 

By Grid – works by inspecting the cloud as a grid to find the lowest valid points in each grid cell 
and keeping only those points.  

 

• From the Project Tree, right-click on the 02- Working Area point cloud and select Bare Earth. 
You can also open the Action tab and click Bare Earth button. 

 
• Name the new cloud 03- Bare Earth. Make sure By Expansion is selected. We want the result to 

be a new bare earthed cloud, so make sure Bare Earth Cloud is selected. There are no 
parameters to worry about, click OK.  
Note that there are a Non-Ground Cloud and Bare Earth Regions options, the later of which will 
classify the current cloud into two regions of ground and not ground.  

The process will take a few minutes depending on the size of the cloud (and your computer). Once 
finished, the program will suggest creating and opening a new scene to view the results. Use the display 
tools to see the resulting cloud from different angles 
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Using Polylines 
Let’s take advantage of the fact that in this data set the roof is white and, since the flight was done at 
noon, there is still some noise in the building area to illustrate how to view a polyline in a different 
scene. 

• In the Project Tree, right-click on the Building_Outline 1-1-#### polyline and select View. 

 
• Select Append to Existing under the Scene for View frame. Then highlight the target scene, in 

our case Scene 03 – Bare Earth and click OK.  

The polyline will be added to the current bare earth scene, and it can be used for selections and other 
features. 

 

 

Delete Points  
Now that we have the building outline added to the current scene, we can use it to delete the ‘noise’ 
left over from the roof.  
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• In the Action tab, under Selection Set, click the Polyline button. 

 
 

• You will be prompted in the scene to select building outline polyline. The program will select all 
the cloud points inside the polyline.  

 
• Now, in the Edit frame, click Delete.  

 
• Accept the prompt. 

 

There are other tools in the Selection Set area allow you to select points individually, by window 
selection, perimeter, elevation range, color, sphere and classification. You can also invert selection set, 
select all points or clear the selection (none).  
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Point Cloud Topo Best Practices 
You now have a point cloud that is ready to develop a topo and thus the question is what the best 
practice is. As every project is different or has it’s own challenges/nuances, let’s briefly touch on 
different techniques. 

• Decimation – As discussed earlier, the point cloud can be decimated using the Clean and 
Resampling filters such that you end with a few thousand points from which you can create a 
TIN surface. Now then, in doing this you risk thinning the cloud to a point that you may lose 
defining features, but this may work well for earthwork/volume calculations if your tolerances 
allow. 

• Direct TIN – Point Cloud Advanced offers a TIN command (Action tab > Create > TIN) which 
allow you to set limits on the triangle side lengths, number of triangulation vertices and density 
limits. The caveat is that the algorithm will decide how to filter data to match the number of 
vertices and point density limit criteria. Not as much or not any point cloud thinning for this but 
again you may lose defining features but this is a quick and easy method that is very 
appropriate for earthwork/volume calculations. 

• Feature Extraction – By extracting features such as building walls/roofs, curbs, road markings, 
parking stripes, sidewalks, edges, general topo points, and other features, you will be able to 
define breaklines and place points that may give you a better representation of your site. In 
addition, by creating the polylines and points, you can quickly develop the plan and create a 
surface in CAD. I recommend this method for sites such as the one being used in this lesson as it 
is an ideal complement to data measured with traditional instruments.  

This said, we will go down the feature extraction path for this lesson as we will be able to extract parking 
lines, curbs, sidewalks, and other edges both automatically and through field-to-finish tools (virtual 
surveying) to add to the building outline that we already have. Then we will draw the resulting 3D 
polylines to CAD and create the surface in Carlson Survey/Civil.  

Lastly, before we begin, note that the following steps in this lesson can be applied in any order as they 
have no pre-requisites. Keep in mind that in your projects you may not be able to use all of these tools.  

 

Extract Parking Lines and Count Stalls 
Let’s start by extracting parking lines as the results can be used for ALTA surveys.  

• In the Scene Viewer, change to a top view and zoom around the parking lot area.  
• Open the Action tab. 
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• From the Extract frame, click Color Lines. 

 
• From the drop-down list, select Parking Lines. 
• We’ll keep the default Layer and Color Tolerance settings. 
• Click Create Selection, in the Scene Viewer, click on a point on a parking stripe. The program will 

find points with the similar RGB values (within tolerance) 

 
• The Stall Length is an approximation of the parking stripe lines, for this example, use 14 (feet). 

You can click Pick to measure if you prefer. 
• Similarly Stall Width is an approximation of the stall width, use 9 (feet). Similarly, you can click 

Pick to measure if you prefer. 
• Click Draw All. The software will analyze the selected data (RGB and clustering) and then trace 

the 3D polylines. The elevation on the polylines is measure from the cloud points on the end 
points and in the middle. Depending on your site (and computer) this will take a few minutes. 

 
In the example below, notice how there are some extra lines resolved in the divider. You will need to do 
some editing as not all the lines might have been picked up (faded paint) or extra lines added (RGB and 
clustering similarity) because we are aiming to do a stall count for ALTA purpose. 
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• Click the Line Editor button.  

 
• Once the editor is open, you can select any parking line in the Scene Viewer and, right-clicking 

will open an actions menu. You will see a listing of all the parking lines that the program created 
followed with their length and a high/low confidence value. You can sort the list and then press 
Zoom To to check the specific lines. 
Some of the actions that you can apply: 

o Create New Line – pick points to draw a new parking stripe. 
o Create Offset Parking Line – allows you to copy and offset any parking line. Once you 

drop the new line in place, the program will obtain the elevation for the line reading the 
cloud points on the new position. 

o Fill in Missing Lines – allows to select to parking lines and then it will suggest the in 
between lines based on the Stall Width parameter.  

o Adjust End Points – allows you to adjust the position of parking line endpoints. 
o Delete Line – deletes the selected line.  
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• For this data set, you will want to delete all the parking lines that are incorrect and may need to 
offset and fill in others. Note that you picked white lines, so none of the handicap blue stalls 
were drawn, you can use the offset parking line command to create them. The reason to do this 
cleanup is that we are going to use the stall counting tool which uses the drawn lines to place 
markers.  
Click OK when you are done editing the lines.  

• Now, let’s count the stalls, click Count Stalls in the Parking Stall Counting frame. 

 
• Use the Remove button to delete any unwanted markers. Then, use the Add/Replace button to 

add missing standard missing markers and then select Handicap under type to add the handicap 
blue markers. The result should be similar to the image below. 

 
• Click the Report button to save/export the stall count. Then, click the Save button to save the 

parking data. 
• Click End Action to close the action panel.  

 

Extract Sidewalks 
The sidewalk extraction tool is also found in the Color Lines tool 
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• In the Scene Viewer, change to a top view and zoom around the sidewalk on the west end of the  
lot.  

• Open the Action tab.  
• From the Extract frame, click Color Lines. Then select Color Edge from the drop-down list. 

 
• Name the Polyline Layer as Sidewalk. 
• Select Sidewalk from the Find Edge Between drop-down list.  
• Click Draw Edge then zoom close the sidewalk that you want to extract and pick a point on the 

sidewalk. 

 
• The program will find and follow the edge as best it can. Note that you have a few actions to 

correct or continue the edge extraction: 
o Adjust Vertex – allows you to graphically correct the position of endpoints. 
o Manual Pick Edge – allows you to manually pick the next point along the edge. 
o Continue Edge – allows you pick another point to continue the edge, the software will 

continue tracing the edge.  
o Trim Edge – will trim the edge line to the selected point. 
o Close Edge – will close the edge. 
o End Edge – completes the tracing of the edge so you can start a new one.  
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• You may need to adjust and continue the edge to complete the sidewalk. When done, click End 
Edge and then click End Action.  
 

Extract Edge by Colors 
Similar to sidewalk extraction, in that the program is using RGB values to find the edges, the next tool 
we will use allows you to select two points and read their RGB values to extract the colored edges.  

• In the Scene Viewer, change to a top view and zoom around the valley gutter on the south of the 
lot.  

• Open the Action tab.  
• From the Extract frame, click Color Lines. Then select Color Edge from the drop-down list. 

 
• Name the Polyline Layer as Drain. 
• Select Color 1 and Color 2 from the Find Edge Between drop-down list.  
• Click the Pick button under the Color 1 swath. Pick a point on the asphalt. 
• Click the Pick button under the Color 2 swath. Pick a point on the valley gutter. 
• Click Draw Edge then zoom close the sidewalk that you want to extract and pick a point on the 

sidewalk. 
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• The program will find and follow the edge as best it can. Note that you have a few actions to 
correct or continue the edge extraction: 

o Adjust Vertex – allows you to graphically correct the position of endpoints. 
o Manual Pick Edge – allows you to manually pick the next point along the edge. 
o Continue Edge – allows you pick another point to continue the edge, the software will 

continue tracing the edge.  
o Trim Edge – will trim the edge line to the selected point. 
o Close Edge – will close the edge. 
o End Edge – completes the tracing of the edge so you can start a new one.  

• You may need to adjust and continue the edge to complete the sidewalk. When done, click End 
Edge and then click End Action.  

• Open the Project tab and click Save. 
 

Editing Layers 
Now that you have added a few more layers and polylines, good time to change layer colors as 
necessary. Note that you can Add new layers and Import layers by reading the layer names in the 
current drawing or from a layer standards file.  

• Open the Project tab. 
• You will see that now the Processed Data tree has been expanded to show the newly created 

polyline in the Polylines branch and that a new layer was added. 
• Right-click on Layers, then click on Edit. 
• Review the current layers and edit the colors as desired by clicking on the Color field on the list. 

Choose the color and click OK. 
• Click OK to close the Layer Manager. 

Your scene may look similar to the one below. 
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Will Curb Extraction work? 
It is important to note that every project is different, and you may not be able to automatically extract 
the curb lines, in which case, follow the steps in the “Create Polylines” section next in the lesson.  

Let’s refresh on how this particular data set was created: drone flight at a low altitude above ground 
level (AGL), specifically 130’.  Sweet spot is between 120’ – 130’ which renders a low ground sampling 
distance (GSD) of 0.03’. Lower AGL will result in lower GSD value and possibly better results but there is 
a point of diminishing returns when too many pictures will cause longer processing times, larger data 
sets, etc. As an example, in the image below, the point cloud on the left was capture with an AGL of 180’ 
versus the cloud on the right which was captured at an AGL of 120’. Please note that an Autel EVO II RTK 
drone with a 20 MP (1” CMOS sensor) was used. Drones with higher end cameras will result with similar 
GSD values at higher altitudes.  

 

 

Ground scanner data will work but keep in mind that you will want to decimate the point cloud such 
that the data doesn’t overwhelm the extraction algorithm. 

 

Extract Curbs 
Alright, with that preamble, let’s extract a curb for this project – note that it is possible that in your 
project curb extraction won’t work on all curbs.  
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• In the Scene Viewer, change to a top view and zoom around the curb on the south side of the lot 
by the valley gutter. 

 
• Open the Action tab.  
• From the Extract frame, click the Curb button. 

 
• The parameters in the image above are good starting point. Min/Max curb height of 0.033/0.67, 

offset of 0.25, search radius of 1.75, snap tolerance of 0.25, and min curb point count of 5. 
• Click the Create Selection button, this will allow you to create a selection set where to focus the 

curb extraction algorithm.  
• You will be prompted for the first point, click close the curb on the southern most end (see 

image below). Then, pick a second point on the other end (see image below). Then right-click to 
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complete the process. 

 
• Click the Extract button.  

 
• Once finished, click End Action. 
• Save the project. 

 

Create Polylines 
As mentioned, you will have challenging areas for automated extraction but the program has a few 
more tools. Let’s start with creating polylines that behaves similar to creating a 3D polyline and includes 
a curb template tool. Note that, if you want to place points and generate linework, you can use the field-
to-finish tools in Create Points (skip to the Field-to-Finish section next). For our lesson, we will add some 
linework around the concrete floor at the building entrance. 

• Zoom around the building area. 
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• Open the Action tab, from the Create frame, click Polyline. 

 
• Select Low Point from the Snap Type pull-down list. Note that there are multiple other options 

to choose from. 
• Make the layer Concrete. 
• Note that the Screen Pick Action is set to Add, which means that you will creating new lines. 

Once again there are several other actions that will allow you to edit the polylines that you 
draw.  

• Click New and now select points around the concrete patio. Note that there are options to draw 
arcs and that you can change the snap type to settings including endpoint to snap to other 
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polylines. The image below is an example of the concrete patio drawn. 

 

 

Draw Polylines to CAD 
In so far, we have extracted or drawn multiple polylines, as you have realized a few more minutes of 
work will allow you to trace most of the linework necessary to complete the drawing. So, time to show 
you how to transfer the polylines from the point cloud manager to the drawing. 

• Open the Project tab, in the Project Tree, right-click on Polylines and select Draw to CAD. 
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• In the Select Polylines to Draw window, click on Select All and then OK.  

 
• Click OK.  
• Click OK to the window confirming the lines were drawn. 
• Minimize the Point Cloud Manager and zoom extents the CAD drawing. 

The image below is an example after both extracting and drawing a good amount of linework. 

 

 

Creating an Exclusion Boundary 
As we continue extracting data from the point cloud to create the topo for the project, we will create an 
exclusion boundary. The concept is that we have plenty of data from the 3D polylines so far to create a 
good model of the paved area of the parking lot and the building patio. To complete the data, we can 
extract points for the rest of the site. From a workflow point of view, you may also consider projects in 
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which you may want to mix data collected with a total station or GNSS receiver with data from the point 
cloud. 

• In CAD, from the Draw menu, select Shrink-Wrap Entities.  

 
• Change the Layer Name to Boundary. 
• The Perimeter Reduction can remain as Medium. 
• For our purpose, it doesn’t matter if the resulting polyline is in 2D or 3D. choose 3D Polyline for 

simplicity and then click OK.  
• Once prompted in CAD, select all the 3D polylines created so far and press ENTER. 
• The software will create the enveloping 3D polyine.  

 

Adding a Polyline from CAD 
Now, let’s add the exclusion boundary to our point cloud scene to illustrate how to you can bring data 
from your CAD drawing into your point cloud project. 

• Restore or reopen the Point Cloud Manager. 
• From the Project tab, in the Project Tree, right click on Polylines, and select Read from CAD. 

 
• Select the polyline we just drew and accept the warning message. 

You will see the exclusion boundary now in the scene viewer. 
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Survey by Grid Points 
Alright, for the most we are only missing topo shots in the unpaved areas. We can get them extracted 
easily. 

• From the Project tab, in the Project Tree, right click on the 03- Bare Earth cloud under Clouds, 
then select Survey by Grid. Note that you can also access this command from the Action tab, 
Create then Points. 

 
• Type a point description, I like a point code that distinguishes point cloud extracted points from 

regular measurements, for example XPC. X regular ground shot, XPC point cloud ground shot.  
• For the starting point number, I also prefer a high number to differentiate from regular shots 

again. For example, 5000. 
• As for grid dimension, this is computer time but for the lesson use 30 by 30 cells. 
• Cell Angle allows you to rotate/orient the grid to best fit the project. In this case we won’t worry 

about this. 
• Point Within is a tolerance to resolve the grid point, keep the default value. 
• Choose the Elevation Method, I recommend Lowest. 
• Make sure Avoid Duplicates is on. 
• Toggle on Use Exclusion Polyine and then click Set. Select the exclusion boundary polyline that 

we brought in from CAD.  
• In this case we are not setting an Inclusion Polyline but you could use to extract points from a 

smaller area. 
• Show Preview will display the grid points allowing you to verify that you are getting the results 

you are looking for. 
• Click OK.  
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• Save the project. 

 

The resulting grid will be like the image below.  

 
 

Field-to-Finish (virtual surveying) 
With all the data extracted so far, you can easily create a topo surface for the project. This said, let’s 
discuss another point tool as this is another practical workflow. We are going to place a few more points 
by setting a point code and graphically selecting their location, for example, for those projects in which 
the field crew might have missed some shots but it would be okay to measure from the cloud rather 
than sending the crew back to the job site. For this lesson, and to illustrate field-to-finish, we will add 
two manhole points. 
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• From the Action tab, Create frame click the Point. 

 
• The Active List is set to Coordinate Points. Remember, we configured the point cloud manager 

to use the CAD project CRD file. 
• Once again, I prefer a high point number to differentiate point cloud points from traditional 

instrument. For example, 4000. 
• Code, this allows you to tap into your field code table file (FLD) that you use in Carlson Survey 

and SurvPC for field-to-finish! To select a field code table (or find a code) click on Code.  

 

Note that you have tools to start line, add a curve (PC), end the line, and close the line. Which means 
that you could use this tool to place points and draw linework automatically as you are used in SurvPC. 

• For this lesson, we will assume that the field code table includes a manhole code (MH). And, if 
the Pipe Feature is configured, we can add more descriptors. Type MH 18 RCP to field-to-finish 
placing a manhole symbol, draw and label that it is an 18” RCP pipe. 

• The Action is set to Add, therefore you are ready to start placing points. Place the two manhole 
points one on the center of the road at the entrance and one further along in the parking lot. 

• Right-click and select End Current Linework.  
• Click End Action. 
• Save the project. 

 

Drawing the Points to CAD 
As we have already placed the lines in CAD, we just need to draw the point. 
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• In the Project tab, right-click on Coordinate Points and select Field-to-Finish 

 
 

• In the Draw Field to Finish window, verify the field code table selected. For our lesson, this 
would be the Carlson.fld code table.  

 
 

• Click OK and the points and lines will be processed in CAD. 
• Save the project. 

 

At this time, you can close the Point Cloud Manager. The drawing will look like the image below with all 
the linework and points that have been extracted. For this lesson, we will assume that you are already 
familiar with creating surfaces with Carlson. For reference, the contours and triangulation will look like 
the remaining images. 
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Other Tools 
Lastly, and for reference, it is good to know that you can also extract powerlines, extract profiles, 
calculate volumes, create features such as poles and trees.  
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